Template 02November2004
Template 02November2004


<Insert OrganizationName>

     
<Insert Name of SAD>
Software Architecture Document
(SAD)

CONTENT OWNER: <Insert Name>

	DOCUMENT NUMBER:
	RELEASE/REVISION:
	RELEASE/REVISION DATE:

	· 
	· 
	· 


	TIPS FOR USING THIS TEMPLATE


To turn on helpful toolbars:
Use the DID Styles toolbar to apply the Word Styles that will be used often in this template. 
Displaying this toolbar will provide quick access to commonly used DID Styles. 
(If the DID Styles Toolbar is not showing, turn it on by selecting View > Toolbars > DID Styles.)

To create an instance of this document:

Insert relevant information on cover sheet.
Insert relevant information in page header: Move to a page of the body of the report, select View > Header and Footer from the main menu, and then replace relevant information in the header box at the top of the page.
A gray box containing CONTENT OF THIS SECTION is provided at the beginning of most sections and subsections. After determining what specific information will be included in your document, you can remove this gray box or leave it to serve as a section overview for your readers.  In the case that text has been provided in the template, the provided text should be inspected for relevance and revised as necessary.  In call cases, relevant text should be added to each section or subsection as appropriate for your document.
Consider hyperlinking key words used in the document with their entries in the Glossary or other location in which they are defined.
To update the contents and page numbers in the Table of Contents, List of Figures, and List of Tables:

Position the cursor anywhere in the Table of Contents.
Click the F9 function key. 

Answer “Update entire table” to each of the next three windows.
To insert a figure caption:

From the main menu, choose Insert > Caption > Figure.
Click the OK button.
Add a colon and a tab stop after the figure number in the caption itself.
The figure caption should use the Caption style.

To insert a table caption:

From the main menu, choose Insert > Reference > Caption > Table. 

Click the OK button.
Then add a colon and a tab stop after the table number in the caption itself. 

The table caption should use the Caption style.

ORGANIZING THE DOCUMENTATION INTO VOLUMES

Consider packaging your SAD as a multi-volume set of documentation.
It is often helpful to break your documentation into more than one volume so that the document does not become unwieldy. There are many ways that this can be accomplished. The structuring of the document must support the needs of the intended audience and must be determined in the context of the project. Each document that you produce should include the date of issue and status; draft, baseline, version number, name of issuing organization; change history; and a summary. A few decomposition options are:

A 2-Volume approach: Separate the documentation into two volumes; one that contains the views of the software architecture and one that contains everything else.  A common variant of this approach has one volume per view, and one volume for everything else.
A 3-Volume approach: Document organizational policies, procedures, and the directory in one volume, system specific overview material in a second, and view documentation in a third.

A 4-Volume approach: Create one volume for each viewtype [Clements 2003] (module, component-and-connector, allocation) that contains the documentation for the relevant views.  Include all of the other information in the fourth volume.

Software interfaces are often documented in a separate volume.  
In any case, the readers should begin with the volume containing the Documentation Roadmap (Section 1 in this template).  


Contents
31
Documentation Roadmap and Overview


31.1
Document Management and Configuration Control Information


31.2
Purpose and Scope of the SAD


51.3
How the SAD Is Organized


61.4
Stakeholder Representation


61.5
Viewpoint Definitions


81.5.1
<Insert name of viewpoint> Viewpoint


91.5.1.1
Abstract


91.5.1.2
Stakeholders and Their Concerns Addressed


91.5.1.3
Elements, Relations, Properties, and Constraints


91.5.1.4
Language(s) to Model/Represent Conforming Views


91.5.1.5
Applicable Evaluation/Analysis Techniques and Consistency/Completeness Criteria


91.5.1.6
Viewpoint Source


101.6
How a View is Documented


111.7
Relationship to Other SADs


111.8
Process for Updating this SAD


122
Architecture Background


122.1
Problem Background


122.1.1
System Overview


122.1.2
Goals and Context


122.1.3
Significant Driving Requirements


122.2
Solution Background


132.2.1
Architectural Approaches


132.2.2
Analysis Results


132.2.3
Requirements Coverage


132.2.4
Summary of Changes in Current Version


132.3
Product Line Reuse Considerations


143
Views


143.1
<Insert view name> View


143.1.1
View Description


143.1.2
View Packet Overview


143.1.3
Architecture Background


143.1.4
Variability Mechanisms


143.1.5
View Packets


153.1.5.1
View packet # j


164
Relations Among Views


164.1
General Relations Among Views


164.2
View-to-View Relations


175
Referenced Materials


186
Directory


186.1
Index


186.2
Glossary


196.3
Acronym List


217
Sample Figures & Tables




List of Figures
3Figure 1:
Sample Figure




 List of Tables

6Table 1:
Stakeholders and Relevant Viewpoints


18Table 2:
Sample Table




1 Documentation Roadmap and Overview

Sub-parts of Section 1 provide information that will help readers or users of the Software Architecture Document (SAD) quickly find information that will enable them to do their jobs.  Readers of the SAD seeking an overview should begin here, as should readers interested in finding particular information to answer a specific question.  See especially Section 1.3 (which explains the information that is found in each section of the SAD), Section 1.4 (which explains the stakeholders for which the SAD has been particularly aimed), Section 1.5 (which explains the viewpoints supported in this SAD), and Section 1.6 (which explains how architectural views are documented in this SAD).  

1.1 Document Management and Configuration Control Information

	CONTENTS OF THIS SECTION: This section identifies the version, release date, and other relevant management and configuration control information associated with the current version of the document. Optional items for this section include: change history and indication of significant changes from version to version.


· Revision Number: << >>
· Revision Date: << >>
· Purpose of Revision: << >>
· Scope of Revision: <<list sections or page numbers that have been revised>>
1.2 Purpose and Scope of the SAD
	CONTENTS OF THIS SECTION: This section explains the SAD’s overall purpose and scope, the criteria for deciding which design decisions are architectural (and therefore documented in the SAD), and which design decisions are non-architectural (and therefore documented elsewhere).


This SAD specifies the software architecture for <insert scope of SAD>.  All information regarding the software architecture may be found in this document, although much information is incorporated by reference to other documents.

The software architecture for a system
 is the structure or structures of that system, which comprise software elements, the externally-visible properties of those elements, and the relationships among them [Bass 2003].  "Externally visible” properties refers to those assumptions other elements can make of an element, such as its provided services, performance characteris​tics, fault handling, shared resource usage, and so on.   This definition provides the basic litmus test for what information is included in this SAD, and what information is relegated to downstream documentation.

The software architecture first and foremost embodies information about how the elements relate to each other. This means that architecture specifi​cally omits certain information about elements that does not pertain to their inter​action. Thus, a software architecture is an abstraction of a system that suppresses details of elements that do not affect how they use, are used by, relate to, or interact with other elements.  Elements interact with each other by means of interfaces that partition details about an element into public and private parts. Software architecture is concerned with the public side of this division, and that will be documented in this SAD accordingly.  On the other hand, private details of elements—details having to do solely with internal implementation—are not architectural and will not be documented in a SAD.

The definition of software architecture makes it clear that systems can and do comprise more than one structure and that no one structure holds the irrefutable claim to being the architecture. The neurologist, the orthopedist, the hematologist, and the dermatologist all take a different perspective on the structure of a human body. Ophthalmologists, cardiolo​gists, and podiatrists concentrate on subsystems. And the kinesiologist and psy​chiatrist are concerned with different aspects of the entire arrangement’s behavior. Although these perspectives are pictured differently and have very different properties, all are inherently related; together they describe the architecture of the human body.  So it is with software. Modern systems are more than complex enough to make it difficult to grasp them all at once. Instead, we restrict our attention at any one moment to one (or a small number) of the software system’s structures. To communicate meaningfully about an architecture, we must make clear which structure or structures we are discussing at the moment—which view we are tak​ing of the architecture.   Thus, this SAD follows the principle that documenting a software architecture is a matter of documenting the relevant views and then documenting information that applies to more than one view.

For example, all non-trivial software systems are partitioned into imple​mentation units; these units are given specific responsibilities, and are the basis of work assignments for programming teams. This kind of element will comprise programs and data that software in other implementation units can call or access, and programs and data that are private. In large projects, the elements will almost certainly be subdivided for assignment to sub-teams. This is one kind of structure often used to describe a system. It is a very static structure, in that it focuses on the way the system’s functionality is divided up and assigned to implementation teams. 

Other structures are much more focused on the way the elements interact with each other at runtime to carry out the system’s function. Suppose the system is to be built as a set of parallel processes. The set of processes that will exist at runtime, the programs in the various implementation units described previously that are strung together sequentially to form each process, and the synchroniza​tion relations among the processes form another kind of structure often used to describe a system. 

None of these structures alone is the architecture, although they all convey architectural information. The architecture consists of these structures as well as many others. This example shows that since architecture can comprise more than one kind of structure, there is more than one kind of element (e.g., implementation unit and processes), more than one kind of interaction among elements (e.g., subdivision and synchronization), and even more than one context (e.g., development time versus runtime). By intention, the definition does not specify what the architectural elements and relationships are. Is a software ele​ment an object? A process? A library? A database? A commercial product? It can be any of these things and more. 

Although software architecture tends to focus on structural information, behavior of each element is part of the software architecture insofar as that behavior can be observed or discerned from the point of view of another ele​ment. This behavior is what allows elements to interact with each other, which is clearly part of the software architecture and will be documented in the SAD as such.  Behavior is documented in the element catalog of each view.
1.3 How the SAD Is Organized

	CONTENTS OF THIS SECTION: This section provides a narrative description of the seven major sections of the SAD and the overall contents of each.   Readers seeking specific information can use Section 1.3 to help them locate it more quickly.


This SAD is organized into the following seven sections:

· Section 1 provides information about this document and its intended audience.  It provides the roadmap and document overview.   Every reader who wishes to find information relevant to the software architecture described in this document should begin by reading Section 1, which describes how the document is organized, which stakeholder viewpoints are represented, how stakeholders are expected to use it, and where information may be found.   Section 1 also provides information about the viewpoints that are used by this SAD to communicate the software architecture.

· Section 2 provides information about the software architecture.  It describes the background and rationale for the software architecture.  It explains the constraints and influences that led to the current architecture, and it describes the major architectural approaches that have been utilized in the architecture.

· Section 3 and Section 4 specify the software architecture.                        

· Sections 5, 6, and 7 provide reference information.  Section 5 provides look-up information for documents that are cited elsewhere in this SAD.  Section 6 is a directory, which is an index of architectural elements and relations telling where each one is defined in this SAD, and where each is used in this SAD. Section 7 provides a glossary and acronym list.

1.4 Stakeholder Representation

	CONTENTS OF THIS SECTION: This section provides a list of the stakeholder roles considered in the development of the architecture described by this SAD. For each, the section lists the concerns that the stakeholder has that can be addressed by the information in this SAD. This information is represented as a matrix, where the rows list stakeholder roles, the columns list concerns, and a cell in the matrix contains an indication of how serious the concern is to a stakeholder in that role. This information is used to motivate the choice of viewpoints chosen in Section 1.5.  The list below provides a sample set of stakeholders for a large organization that may be developing a complex system. For example, a maintainer’s concerns include knowing what software elements may be affected by a change. This list will be tailored for each organization that is developing a SAD.

ANSI/IEEE 1471-2000 requires that at least the following stakeholders be considered:  users, acquirers, developers, and maintainers.

	Customer

Application software developers

Infrastructure software developers

End users

Application system engineers

Application hardware engineers
	Project manager

Communications engineers

Chief Engineer/Chief Scientist

Program management

System and software integration and test engineers

Safety engineers and certifiers
	External  organizations

Operational system managers

Trainers

Maintainers

Auditors 

Security engineers and certifiers


1.5 Viewpoint Definitions

	CONTENTS OF THIS SECTION: This section provides a short textual definition of a viewpoint and how the concept is used in this SAD.   The section describes viewpoints that may be used in the SAD. The specific viewpoints will be tailored by the organization. 


The SAD employs a stakeholder-focused, multiple view approach to architecture documentation, as required by ANSI/IEEE 1471-2000, the recommended best practice for documenting the architecture of software-intensive systems [IEEE 1471].  

Each stakeholder of a software system—customer, user, project manager, coder, analyst, tester, and so on—is concerned with different characteristics of the system that are affected by its software architecture. For example, the user is concerned that the system is reliable and available when needed; the customer is concerned that the archi​tecture can be implemented on schedule and to budget; the manager is worried (in addition to cost and schedule) that the architecture will allow teams to work largely independently, interacting in disciplined and controlled ways. The devel​oper is worried about strategies to achieve all of those goals. The security analyst is concerned that the system will meet its information assurance requirements, and the performance analyst is similarly concerned with it satisfying real-time deadlines. 

As described in Section 1.2, a software architecture comprises more than one software structure, each of which provides an engineering handle on different system qualities.  A view is the specification of one or more of these structures, and documenting a software architecture, then, is a matter of documenting the relevant views and then documenting information that applies to more than one view [Clements 2003].   

ANSI/IEEE 1471-2000 provides guidance for choosing the best set of views to document, by bringing stakeholder interests to bear.  It prescribes defining a set of viewpoints to satisfy the stakeholder community.  A viewpoint identifies the set of concerns to be addressed, and identifies the modeling techniques, evaluation techniques, consistency checking techniques, etc., used by any conforming view.  A view, then, is a viewpoint applied to a system.  It is a representation of a set of software elements, their properties, and the relationships among them that conform to a defining viewpoint.  Together, the chosen set of views show the entire architecture and all of its relevant properties.  A SAD contains the viewpoints, relevant views, and information that applies to more than one view to give a holistic description of the system.  

Architectural views can by and large be divided into three groups, depending on the broad nature of the elements they show. These are:

· Module views. Here, the elements are modules, which are units of implementation. Modules represent a code-based way of considering the system. Modules are assigned areas of functional responsibility, and are assigned to teams for implementation. There is less emphasis on how the resulting software manifests itself at runtime. Module structures allow us to answer questions such as: What is the primary functional responsibility assigned to each module? What other software elements is a module allowed to use? What other software does it actually use? What modules are related to other modules by generalization or specialization (i.e., inherit​ance) relationships? 

· Component-and-connector views. Here, the elements are runtime com​ponents (which are principal units of computation) and connectors (which are the communication vehicles among components). Component and con​nector structures help answer questions such as: What are the major execut​ing components and how do they interact? What are the major shared data stores? Which parts of the system are replicated? How does data progress through the system? What parts of the system can run in parallel? How can the system’s structure change as it executes? 

· Allocation views. These views show the relationship between the software elements and elements in one or more external environments in which the software is created and executed. Allocation structures answer questions such as: What processor does each software element execute on? In what files is each element stored during development, testing, and system building? What is the assignment of the software element to development teams?

These three kinds of structures correspond to the three broad kinds of deci​sions that architectural design involves: 

· How is the system to be structured as a set of code units (modules)?

· How is the system to be structured as a set of elements that have run-time behavior (components) and interactions (connectors) ?

· How is the system to relate to non-software structures in its environment (such as CPUs, file systems, networks, development teams, etc.)? 

The remainder of Section 1.5 defines the viewpoints used in this SAD. The following table summarizes the stakeholders in this project and the viewpoints that have been included to address their concerns.
Table 1:
Stakeholders and Relevant Viewpoints

	Stakeholder
	Viewpoints

	
	

	
	

	
	

	
	


1.5.1 <Insert name of viewpoint> Viewpoint

	1.5 Example viewpoint definition:
Viewpoint #1.   Module decomposition viewpoint
1.5.1.1  Abstract.  Views conforming to the module decomposition viewpoint partition the system into a unique non-overlapping set of hierarchically decomposable implementation units (modules).
1.5.1.2  Stakeholders and Their Concerns Addressed.  Stakeholders and their concerns addressed by this viewpoint include 

· project managers, who must define work assignments, form teams, and formulate project plans and budgets and schedules; 

· COTS specialists, who need to have software elements defined as units of functionality, so they can search the marketplace and perform trade studies to find suitable COTS candidates; 

· testers and integrators who use the modules as their unit of work; 

· configuration management specialists who are in charge of maintaining current and past versions of the elements; 

· system build engineers who use the elements to produce a running version of the system; 

· maintainers, who are tasked with modifying the software elements; 

· implementers, who are required to implement the elements; 

· software architects for those software elements sufficiently large or complex enough to warrant their own software architectures; 

· the customer, who is concerned that projected changes to the system over its lifetime can be made economically by confining the effects of each change to a small number of elements.

1.5.1.3  Elements, Relations, Properties, and Constraints.  Elements of the module decomposition viewpoint are modules, which are units of implementation that provide defined functionality.  Modules are hierarchically decomposable; hence, the relation is “is-part-of.”  Properties of elements include their names, the functionality assigned to them (including a statement of the quality attributes associated with that functionality), and their software-to-software interfaces.  The module properties may include requirements allocation, supporting requirements traceability.

1.5.1.4  Language(s) to Model/Represent Conforming Views.  Views conforming to the module decomposition viewpoint may be represented by (a) plain text using indentation or outline form [Clements 2003]; (b) UML, using subsystems or classes to represent elements and “is part of” or nesting to represent the decomposition relation.

1.5.1.5  Applicable Evaluation/Analysis Techniques and Consistency/Completeness Criteria.  Completeness/consistency criteria include (a) no element has more than one parent; (b) major functionality is provided for by exactly one element; (c) the union of all elements’ functionality covers the requirements for the system; (d) every piece of source code can be mapped to an element in the module decomposition view (if not, the view is not complete); (e) the selection of module aligns with current and proposed procurement decisions. Additional consistency/completeness criteria apply to the specifications of the elements’ interfaces.  Applicable evaluation/analysis techniques include (a) scenario-based evaluation techniques such as ATAM [Clements 2001] to assure that projected changes are supported economically by the decomposition; (b) disciplined and detailed mapping to requirements to assure coverage and non-overlapping functionality; (c) cost-based techniques that determine the number and composition of modules for efficient procurement.

1.5.1.6  Viewpoint Source.   [Clements 2003, Section 2.1] describes the module decomposition style, which corresponds in large measure to this viewpoint.  


1.5.1.1 Abstract

	CONTENTS OF THIS SECTION: In this section, a brief overview of the viewpoint is provided.


1.5.1.2 Stakeholders and Their Concerns Addressed

	CONTENTS OF THIS SECTION: This section describes the stakeholders and their concerns that this viewpoint is intended to address. Listed are questions that can be answered by consulting views that conform to this viewpoint. Optionally, the section includes significant questions that cannot be answered by consulting views conforming to this viewpoint. 


1.5.1.3 Elements, Relations, Properties, and Constraints

	CONTENTS OF THIS SECTION: This section defines the types of elements, the relations among them, the significant properties they exhibit, and the constraints they obey for views conforming to this viewpoint.


1.5.1.4 Language(s) to Model/Represent Conforming Views

	CONTENTS OF THIS SECTION: This section lists the language or languages that will be used to model or represent views conforming to this viewpoint, and cite a definition document for each. 


1.5.1.5 Applicable Evaluation/Analysis Techniques and Consistency/Completeness Criteria

	CONTENTS OF THIS SECTION: This section describes rules for consistency and completeness that apply to views in this viewpoint, as well as any analysis of evaluation techniques that apply to the view that can be used to predict qualities of the system whose architecture is being specified.


1.5.1.6 Viewpoint Source

	CONTENTS OF THIS SECTION: This section provides a citation for the source of this viewpoint definition, if any.


1.6 How a View is Documented

	CONTENTS OF THIS SECTION: This section describes how the documentation for a view is structured and organized.


Section 3 of this SAD contains one view for each viewpoint listed in Section 1.5.  Each view is documented as a set of view packets.  A view packet is the smallest bundle of architectural documentation that might be given to an individual stakeholder.

Each view is documented as follows, where the letter i stands for the number of the view:  1, 2, etc.:

· Section 3.i:  Name of view.

· Section 3.i.1: View description.  This section describes the purpose and contents of the view. It should refer to (and match) the viewpoint description in Section 1.5 to which this view conforms.

· Section 3.i.2: View packet overview.  This section shows the set of view packets in this view, and provides rationale that explains why the chosen set is complete and non-duplicative.  The set of view packets may be listed textually, or shown graphically in terms of how they partition the entire architecture being shown.

· Section 3.i.3:  Architecture background.  Whereas the architecture background of Section 2 pertains to those constraints and decisions whose scope is the entire architecture, this section provides any architecture background (including significant driving requirements, design approaches, patterns, analysis results, and requirements coverage) that applies to this view.

· Section 3.i.4: Variability mechanisms.  This section describes any architectural variability mechanisms (e.g., adaptation data, compile-time parameters, variable replication, and so forth) described by this view, including a description of how and when those mechanisms may be exercised and any constraints on their use.
· Section 3.i.5: View packets.  This section presents all of the view packets given for this view.  Each view packet is described using the following outline, where the letter j stands for the number of the view packet being described: 1, 2, etc.
· Section 3.i.5.j: View packet #j.

· Section 3.i.5.j.1: Primary presentation.  This section presents the elements and the relations among them that populate this view packet, using an appropriate language, languages, notation, or tool-based representation.

· Section 3.i.5.j.2: Element catalog.  Whereas the primary presentation shows the important elements and relations of the view packet, this section provides additional information needed to complete the architectural picture.   It consists of the following subsections:

· Section 3.i.5.j.2.1:  Elements.  This section describes each element shown in the primary presentation, details its responsibilities of each element, and specifies values of the elements’ relevant properties, which are defined in the viewpoint to which this view conforms.

· Section 3.i.5.j.2.2:  Relations.  This section describes any additional relations among elements shown in the primary presentation, or specializations or restrictions on the relations shown in the primary presentation.

· Section 3.i.5.j.2.3:  Interfaces.  This section specifies the software interfaces to any elements shown in the primary presentation that must be visible to other elements.

· Section 3.i.5.j.2.4: Behavior.  This section specifies any significant behavior of elements or groups of interacting elements shown in the primary presentation.

· Section 3.i.5.j.2.5: Constraints:  This section lists any constraints on elements or relations not otherwise described.

· Section 3.i.5.j.3: Context diagram. This section provides a context diagram showing the context of the part of the system represented by this view packet. It also designates the view packet’s scope with a distinguished symbol, and shows interactions with external entities in the vocabulary of the view.
· Section 3.i.5.j.4: Variability mechanisms.   This section describes any variabilities that are available in the portion of the system shown in the view packet, along with how and when those mechanisms may be exercised.
· Section 3.i.5.j.5: Architecture background.  This section provides rationale for any significant design decisions whose scope is limited to this view packet.
· Section 3.i.5.j.6: Relation to other view packets.  This section provides references for related view packets, including the parent, children, and siblings of this view packet. Related view packets may be in the same view or in different views.
1.7 Relationship to Other SADs

	CONTENTS OF THIS SECTION: This section describes the relationship between this SAD and other architecture documents, both system and software. 


1.8 Process for Updating this SAD
	CONTENTS OF THIS SECTION: This section describes the process a reader should follow to report discrepancies, errors, inconsistencies, or omissions from this SAD. The section also includes necessary contact information for submitting the report. If a form is required, either a copy of the blank form that may be photocopied is included, or a reference to an online version is provided. This section also describes how error reports are handled, and how and when a submitter will be notified of the issue’s disposition.


2 Architecture Background

2.1 Problem Background

	CONTENTS OF THIS SECTION: The sub-parts of Section 2.1 explain the constraints that provided the significant influence over the architecture. 


2.1.1 System Overview

	CONTENTS OF THIS SECTION: This section describes the general function and purpose for the system or subsystem whose architecture is described in this SAD. 


2.1.2 Goals and Context

	CONTENTS OF THIS SECTION: This section describes the goals and major contextual factors for the software architecture. The section includes a description of the role software architecture plays in the life cycle, the relationship to system engineering results and artifacts, and any other relevant factors. 


2.1.3 Significant Driving Requirements

	CONTENTS OF THIS SECTION: This section describes behavioral and quality attribute requirements (original or derived) that shaped the software architecture. Included are any scenarios that express driving behavioral and quality attribute goals, such as those crafted during a Quality Attribute Workshop (QAW) [Barbacci 2003] or software architecture evaluation using the Architecture Tradeoff Analysis MethodSM (ATAMSM) [Bass 2003].


2.2 Solution Background

	CONTENTS OF THIS SECTION: The sub-parts of Section 2.2 provide a description of why the architecture is the way that it is, and a convincing argument that the architecture is the right one to satisfy the behavioral and quality attribute goals levied upon it.


2.2.1 Architectural Approaches

	CONTENTS OF THIS SECTION: This section provides a rationale for the major design decisions embodied by the software architecture. It describes any design approaches applied to the software architecture, including the use of architectural styles or design patterns, when the scope of those approaches transcends any single architectural view. The section also provides a rationale for the selection of those approaches.  It also describes any significant alternatives that were seriously considered and why they were ultimately rejected.  The section describes any relevant COTS issues, including any associated trade studies.


2.2.2 Analysis Results

	CONTENTS OF THIS SECTION: This section describes the results of any quantitative or qualitative analyses that have been performed that provide evidence that the software architecture is fit for purpose. If an Architecture Tradeoff Analysis Method evaluation has been performed, it is included in the analysis sections of its final report. This section refers to the results of any other relevant trade studies, quantitative modeling, or other analysis results.


2.2.3 Requirements Coverage

	CONTENTS OF THIS SECTION: This section describes the requirements (original or derived) addressed by the software architecture, with a short statement about where in the architecture each requirement is addressed. 


2.2.4 Summary of Changes in Current Version

	CONTENTS OF THIS SECTION: For versions of the SAD after the original release, this section summarizes the actions, decisions, decision drivers, analysis and trade study results that became decision drivers, requirements changes that became decision drivers, and how these decisions have caused the architecture to evolve or change.


2.3 Product Line Reuse Considerations

	CONTENTS OF THIS SECTION: When a product line is being developed, this section details how the software covered by this SAD is planned or expected to be reused in order to support the product line vision. In particular, this section includes a complete list of the variations that are planned to be produced and supported. "Variation" refers to a variant of the software produced through the use of pre-planned variation mechanisms made available in the software architecture. It may refer to a variant of one of the modules identified in this SAD, or a collection of modules, or the entire system or subsystem covered by this SAD. For each variation, the section identifies the increment(s) of the  software build in which (a) the variation will be available; and (b) the variation will be used. Finally, this section describes any additional potential that exists to reuse one or more of the modules or their identified variations, even if this reuse is not currently planned for any increment.


3 Views

	CONTENTS OF THIS SECTION: The sub-parts of Section 3 specify the views corresponding to the viewpoints listed in Section 1.5.   


3.1 <Insert view name> View

	CONTENTS OF THIS SECTION: For each view documented in this SAD, the sub-parts of Section 3.1 specify it using the outline given in Section 1.6. 


3.1.1 View Description

3.1.2 View Packet Overview

3.1.3 Architecture Background

3.1.4 Variability Mechanisms

3.1.5 View Packets

	CONTENTS OF THIS SECTION: For each view packet in the view, this section describes it using the outline given in Section 1.6.


3.1.5.1 View packet # j

3.1.5.1.1 Primary Presentation

3.1.5.1.2 Element Catalog

3.1.5.1.2.1 Elements

3.1.5.1.2.2 Relations

3.1.5.1.2.3 Interfaces

3.1.5.1.2.4 Behavior

3.1.5.1.2.5 Constraints

3.1.5.1.3 Context Diagram

3.1.5.1.4 Variability Mechanisms

3.1.5.1.5 Architecture Background

3.1.5.1.6 Related View Packets

4 Relations Among Views 

Each of the views specified in Section 3 provides a different perspective and design handle on a system, and each is valid and useful in its own right. Although the views give different system perspectives, they are not independent. Elements of one view will be related to elements of other views, and we need to reason about these relations. For example, a module in a decomposition view may be man​ifested as one, part of one, or several components in one of the component-and-connector views, reflecting its runtime alter-ego. In general, mappings between views are many to many.   Section 4 describes the relations that exist among the views given in Section 3.  As required by ANSI/IEEE 1471-2000, it also describes any known inconsistencies among the views.

4.1 General Relations Among Views

	CONTENTS OF THIS SECTION: This section describes the general relationship among the views chosen to represent the architecture. Also in this section, consistency among those views is discussed and any known inconsistencies are identified.


4.2 View-to-View Relations

	CONTENTS OF THIS SECTION: For each set of views related to each other, this section shows how the elements in one view are related to elements in another. 


5 Referenced Materials

	CONTENTS OF THIS SECTION: This section provides citations for each reference document. Enough information is provided so that a reader of the SAD can be reasonably expected to locate the document.


	Barbacci 2003
	Barbacci, M.; Ellison, R.; Lattanze, A.; Stafford, J.; Weinstock, C.; & Wood, W. Quality Attribute Workshops (QAWs), Third Edition (CMU/SEI-2003-TR-016). Pittsburgh, PA: Software Engineering Institute, Carnegie Mellon University, 2003. <http://www.sei.cmu.edu/publications/documents/03.reports/03tr016.html>.

	Bass 2003
	Bass, Clements, Kazman, Software Architecture in Practice, second edition, Addison Wesley Longman, 2003.

	Clements 2001
	Clements, Kazman, Klein, Evaluating Software Architectures: Methods and Case Studies, Addison Wesley Longman, 2001.

	Clements 2003
	Clements, Bachmann, Bass, Garlan, Ivers, Little, Nord, Stafford, Documenting Software Architectures: Views and Beyond, Addison Wesley Longman, 2003.

	IEEE 1471
	ANSI/IEEE-1471-2000, IEEE Recommended Practice for Architectural Description of Software-Intensive Systems, 21 September 2000.


6 Directory

6.1 Index
	CONTENTS OF THIS SECTION: This section provides an index of all element names, relation names, and property names. For each entry, the following are identified:

the location in the SAD where it was defined 

each place it was used


6.2 Glossary 

	CONTENTS OF THIS SECTION: This section provides a list of definitions of special terms and acronyms used in the SAD. If terms are used in the SAD that are also used in a parent SAD and the definition is different, this section explains why.


	Term
	Definition

	software architecture
	The structure or structures of that system, which comprise software elements, the externally visible properties of those elements, and the relationships among them [Bass 2003].  "Externally visible” properties refer to those assumptions other elements can make of an element, such as its provided services, performance characteris​tics, fault handling, shared resource usage, and so on.

	view
	A representation of a whole system from the perspective of a related set of concerns [IEEE 1471]. A representation of a particular type of software architectural elements that occur in a system, their properties, and the relations among them.  A view conforms to a defining viewpoint.

	view packet
	The smallest package of architectural documentation that could usefully be given to a stakeholder.  The documentation of a view is composed of one or more view packets.

	viewpoint
	A specification of the conventions for constructing and using a view; a pattern or template from which to develop individual views by establishing the purposes and audience for a view, and the techniques for its creation and analysis [IEEE 1471]. Identifies the set of concerns to be addressed, and identifies the modeling techniques, evaluation techniques, consistency checking techniques, etc., used by any conforming view.  


6.3 Acronym List

	API
	Application Programming Interface; Application Program Interface; Application Programmer Interface

	ATAM
	Architecture Tradeoff Analysis Method

	CMM
	Capability Maturity Model

	CMMI
	Capability Maturity Model Integration

	CORBA
	Common object request broker architecture

	COTS
	Commercial-Off-The-Shelf

	EPIC
	Evolutionary Process for Integrating COTS-Based Systems

	IEEE
	Institute of Electrical and Electronics Engineers

	KPA
	Key Process Area

	OO
	Object Oriented

	ORB
	Object Request Broker

	OS
	Operating System

	QAW
	Quality Attribute Workshop

	RUP
	Rational Unified Process

	SDE
	Software Development Environment

	SEE
	Software Engineering Environment

	SEI
	Software Engineering Institute
Systems Engineering & Integration
Software End Item

	SEPG
	Software Engineering Process Group

	SLOC
	Source Lines of Code

	SW-CMM
	Capability Maturity Model for Software

	CMMI-SW
	Capability Maturity Model Integrated - includes Software Engineering

	UML
	Unified Modeling Language
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Appendix A   Appendices

	CONTENTS OF THIS SECTION: Appendices may be used to provide information published separately for convenience in document maintenance (e.g., charts, classified data, API specification). As applicable, each appendix is referenced in the main body of the document where the data would normally have been provided. Appendices may be bound as separate documents for ease in handling.


A.1 Heading 2 - Appendix

A.2 Heading 2 - Appendix







� Here, a system may refer to a system of systems.


SM Quality Attribute Workshop  and QAW and Architecture Tradeoff Analysis Method and ATAM are service marks of Carnegie Mellon University.
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